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1.

Introduction

GD-Link V2 is a rich-featured, easy-to-use, and portable debugging and programming tool
developed by GigaDevice for GD32 series MCU, which has the following characteristics:

USB2.0 high-speed interface

Provide 5V or 3.3V power supply for the target chip

Support firmware update through the GD-Link Programmer software
Support SWD / JTAG debugging and programming interface
Support GD32 ARM / RISC-V core full series of chips

Support KEIL / IAR / Eclpise debugging and programming

Support offline programming

Support virtual USB disk drag and drop programming

Support SWO function

Support virtual serial port printing
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2. Hardware introduction

2.1. Pin definitions and wiring methods

To enable programming, debugging, serial communication, and printing functions, connect
the GD-Link V2 pins to the SWD (SWO), JTAG, or USART interface of the target chip using
DuPont wires or ribbon cables. The pinout of GD-Link V2 is illustrated in Figure 2-1. GD-Link
V2 pinout diagram.

Figure 2-1. GD-Link V2 pinout diagram

Target MCU

—_ T Vref IP2

GND

T T, S T _TMS/IO
: Y T TCK/CLK
USARTI_TX i . T TDO
USARTI RX ; : T _1DI
L9 10 T Reset

—  5x2P2.54
iND

@

The functions of each GD-Link V2 pin are described as shown in Table 2-1. GD-Link V2 pin
function definitions.

Table 2-1. GD-Link V2 pin function definitions

Pin Number Pin Name Description
1 T_Vref Target chip power supply, providing 3.3V / 5V
2 T_TMS/IO JTAG TMS pin / SWD SWDIO pin
3 GND Power ground
4 T_TCK/CLK JTAG TCK pin / SWD CLK pin
5 USART1_TX Serial transmission pin
6 T_TDO JTAG TDO pin / SWO pin
7 USART1_RX Serial reception pin
8 T_TDI JTAG TDI pin
9 GND Power ground
10 T_Reset JTAG / SWD target chip reset pin

The diagram of GD-Link V2 hardware connection to the target chip is illustrated in Figure 2-2.
SWD .interface connection diagram, Figure 2-3. JTAG interface connection diagram,
Figure 2-4. SWD + SWO interface connection diagram and Figure 2-5. Serial interface

connection diagram.
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Figure 2-2. SWD interface connection diagram

T Vref 1 VCC
T_TMS/IO 2 SWDIO
T _TCK/CLK 4 SWCLK
GND 39 GND
T Reset 10 NRST
(optional)
GD-Link V2 Target MCU

Figure 2-3. JTAG interface connection diagram

T Vref 1 vCC
T_TMS/IO 2 T™MS
T_TCK/CLK 4 TCK
T.TDO ¢ TDO
T TDI 8 TDI
GND 3,9 GND
(optiona) ™
GD-Link V2 Target MCU
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Figure 2-4. SWD + SWO interface connection diagram
T_Vref 1 VCC
T_TMS/IO 2 SWDIO
T_TCKICLK 4 SWCLK
T_TDO 6 SWO
GND 39 GND
T Reset 10 NRST
(optional)
GD-Link V2 Target MCU
Figure 2-5. Serial interface connection diagram
T Vref 1 VCC
USART_TX 5 RX
USART_RX 7 TX
GND 3,9 GND
GD-Link V2 Target MCU
2.2. Button, LEDs and Buzzer

GD-Link V2 features a single button (K1), a buzzer (BZ1) and four LEDs (LED1/2/3/4) as
indicators. The physical representation of GD-Link V2 is shown in Eigure 2-6. GD-Link V2
adapter hardware. The button K1 is used for firmware updates and offline programming. For
specific usage instructions, please refer to the firmware update and offline programming

section.
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Figure 2-6. GD-Link V2 adapter hardware
During offline programming and drag-and-drop programming from a virtual USB disk, when
the target chip has been successfully programmed with the desired file, the buzzer will beep,
indicating a successful programming status. The on-off and blinking of the LED indicate
different working states of GD-Link V2. Table 2-2. Working status of GD-Link V2 provides
a description of the different status of these LEDs which indicate the status of programming
and debugging tool.
Table 2-2. Working status of GD-Link V2
LED LED status GD-Link V2 working status
) Offline programming or drag-and-drop
always bright )
programming successful
LED1
) performing offline programming or drag-and-
flashing )
drop programming
flashing fast USB connection successful
LED2
flashing slow USB not connected
LED3 always bright Firmware update status
LED4 always bright Power supply is normal
2.3. Output voltage

The debugger provides 5V and 3.3V output voltages for users to choose. The output voltage
can be modified by short-connecting the R12 and R13 resistors in the hardware through the
0Q resistor. The schematic diagram of the voltage selection is shown in Figure 2-7. GD-Link
V2 output voltage select. Reference Figure 2-6. GD-Link V2 adapter hardware, when the
0Q resistor is welded at R13, the T_Vref voltage is 3.3V, when the 0Q resistor is welded at
R13, and the output T_Vref voltage is 5V.

10
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Figure 2-7. GD-Link V2 output voltage select

Voltage Select

R12
+5VOp—— P22
R13
3v3 f— 2 l—lT_x-'ref
Target Voltage R12 | R13
3V3 NC | FIT
5V0 FIT | _NC

11
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3.

3.1.

Software features

Firmware updates

GD-Link V2 provides firmware update functionality. Firmware updates are used to:

B Support the latest MCUs released by GD32.
B Fix issues present in the firmware.

GD-Link V2 can be updated using the GD-Link Programmer software. Users can visit the
GD32MCU official website to obtain the latest version of the GD-Link Programmer software,
unzip it after downloading, and follow these firmware update steps:

1. Disconnect GD-Link V2 from the computer's USB port.

2. While holding down button K1, plug GD-Link V2 back into the computer's USB port. At
this time, LED3 is always on, indicating that the programmer is in firmware upgrade mode.

3. Release button K1 and click the "GD-Link" menu in the GD-Link Programmer software.
Choose "Update Firmware" to start the firmware update process.

4.  Aprogress bar will pop up in the GD-Link Programmer software, indicating the progress
of the update. Wait for it to reach 100% and show a successful update message.

Refer to Figure 3-1. GD-Link V2 firmware update step 1, Figure 3-2. GD-Link V2 firmware
update step 2 and Figure 3-3. GD-Link V2 firmware update step 3 for visual guidance on
the firmware update process.

Figure 3-1. GD-Link V2 firmware update step 1

% GD-Link Programmer 4.7.14.19076 — =] X

¢ FilelF) Target

RAM Address Unknown
RAM Size

up

Flash Info

size

Flash Base .. Unknown

Show initial information wnd softwere information hers,

) % Status

CAP NUM SCRL

12
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Figure 3-2. GD-Link V2 firmware update step 2

a5 GD-Link Programmer 47.14.19076 — [m] X

i Filelf) Target GD-link Refresh Edit) ViewlV) Help(H]

Device(GD-Link)
Connect Unknown
Device Inter... SWD
Firmware Ve... Unknown
uD Unknown
B JTAG/SWD
Initial Speed 10000 kHz
& MCU Info
MCU Part No. Unknown
. Endian Unknown
GD-Link Programmer X Check core D Yes
Core ID Unknown
Please make sure DO NOT disconnect frem PC in upgrade process! Use RAM Ves
Confirm to upgrade to Firmware version 17 RAM Address Unknown
RAM Size Unknown
vip Unknown
e [ B
Size Unknown
Flash Base ..  Unknown
Show initial infermation and seftwars informstion hers.

Figure 3-3. GD-Link V2 firmware update step 3

i GD-Link Programmer 4.7.14.19076 - o x
© Fle) Torget GD.ink Refresh EdtE) View\V) Help(H)

& Device(GD-Link)
Connect Unknown
Device Inter... SWD
Firmware Ve... Unknown

uD Unknown
B JTAG/SWD
Initial Speed 10000 kHz
i E MCU Info
GOk Progress * MCU Part No.  Unknown
Endian Unknown
Operation:  Upgrading GD-Link firmware: Check core ID Yes.

Core ID Unknown

RealTme:  Upgrading GD-Uink firmware Successfully!
Time Cost:  5.8285

Use RAM Ves.
RAM Address  Unknown
RAMSize  Unknown

v
(| e
Size Unknown

Flash Base .. Unknown

]

Show initial information and roftware infermation here

M 4 b w O\ Status

Ready CAP NUM SCRL

After the update is completed, user can check the current firmware version number in the
properties pane, as shown in Figure 3-4. GD-Link V2 firmware update step 4.

13
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Figure 3-4. GD-Link V2 firmware update step 4

5 GD-Link Programmer 471419076 - o x

i Filelf) Target GD-link Refresh Edit) ViewlV) Help(H]

ice(GD-Link)
7238B60A0934F.
ice Inter.,  SWD.

1
5047204B15373...

Initial Speed 10000 kHz
£ MCU Info
MCU Part No. Unknown

Endian Unknown
Check core ID Yes
Core ID Unknown
UseRAM  YVes
RAM Address  Unknown
RAM Size Unknown
uip Unknown
E Flash Info
Size Unknown
Flash Base .. Unknown

|

Show initial infornation snd software information here.

< » v \Status

Ready CAP NUM SCRL

Note: During the firmware update process, do not unplug GD-Link V2 from the computer's

USB port.
3.2. Programming function
3.2.1. IDE programming

Programming with KEIL (version 5.27 and above):

Connect GD-Link V2 to the target chip according to the hardware connection described in Pin
definitions and wiring methods section. Connect the USB interface of GD-Link V2 to the
PC, and wait for LED2 to enter rapid blinking mode. Open KEIL software, in the KEIL Debug
tab, select "CMSIS-DAP Debugger" or "CMSIS-DAP ARMv8-M Debugger" in the "Debug"
option, as shown in Figure 3-5. KEIL debug configuration.

14
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Figure 3-5. KEIL debug configuration

K38 Options for Target 'GD32F1C

" Use Simulator #ith restrictions

Device ] Target ] Output I Listing] User I CAC++ ] Azm ] Linker Utilities ] 2

1

Settings | Il': Use: |CMSIS—DAP Debugger

Ao

[™ Limit Speed to Real-Time

CMSIS-DAP Cortex-M Target Driver Setup

Debug lTrace ]Flash Download]

SW Device

s

CMSIS-DAP - JTAG/SW Adapter
| us15-DAF vZIETRE| |

SWDIO

IDCODE

Device Name
® x1BAD1477  ARM CoreSight SW-DP |

Serial No: [FDAD2457FADD
Firmware Version: |0255

[v SWJ Port:|sw -1 4

Max Clock: | 5MHz hd

[0

—
|

| AP:

00

Debug
Connect & Reset Options

Connect: | Normal

[V Reset after Connect
™ Log Debug Accesses

| Reset: [Autodetect

Cache Options Download Options
j |v Cache Code I~ Verify Code Download
¥ Cache Memary ™ Download to Flash

I” Stop after Reset

= ]

Cancel |

Help

In the "Utilities" tab, select "Use Debug Driver" and click the "Setting" button to choose the
MCU download algorithm and configure the erase mode and other settings, as shown in
Figure 3-6. KEIL utilities configuration.

Figure 3-6. KEIL utilities configuration

3 Options for Target 'GD32F1(

Configure Flash Menu Command
{* |se Target Driver for Flash Programming

— Use Debug Driver —
|

Tevice I Target] Output ] Listing] User ] CAC++ ] hsm ] Lin](er] Debuz

3 Settings ¥ Update Target before Debugging

9

2|V Use Debug Driver

CMSIS-DAP Cortex-M Target Driver Setup
Debug ] Trace Flazh Downlead l
Download Function 4

pofp | © Erase Full Chip| ¥ Program
{* FErase Sectors | v Verify

;i " Do not Erase

Programming Algorithm

RAM for Algorithm

Start: | (20000000
[w Reset and Run

Size: | (00001000

Description | Device Size | Device Type | Address Range
GD32F 10w Extra-density FMC am On-chip Fash 08000000H - 082FFFFFH
5
Start: | Size:

Click the "Download" icon in the KEIL menu bar. In the "Build Output" window, the
programming progress can be monitored, as shown in Figure 3-7. KEIL Download Icon and

15
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Figure 3-8. Build output window - programming successful.

Figure 3-7. KEIL Download Icon
- 1][¥%] epszrimixo " K

N 4
&

Figure 3-8. Build output window - programming successful

Full Chip Erase Done.
Programming Done.

Verify CK.

Flash Load finished at le:06:29

Programming with IAR (version 8.50 and above):

Connect GD-Link V2 to the target chip according to the the hardware connection described
in Pin definitions and wiring methods section. Connect the USB interface of GD-Link V2
to the PC, and wait for LED2 to enter rapid blinking mode. Open IAR software. In the IAR
"Project" menu, choose "Options." In the "Debugger" tab, choose "CMSIS-DAP" as the
debugger driver, as shown in Figure 3-9. IAR debugger configuration. In the "Setup” tab,
choose the MCU type, download algorithm, and other configurations according to the target
chip's requirements, as shown in Figure 3-10. IAR CMSIS DAP configuration.

Figure 3-9. IAR debugger configuration

Options for node "GD32103B_EVAL" X

Categary: Factory Settings

General Options
Static Analysis
Runtime Checking

C/fC++ Compiler Setup Download Images Multicore Extra Options Plugins
Assembler

Output Converter . 2

Custom Build Driver Run to

Setup macros
Simulator P

Capt [JUse macro file(s)
CMSIS DAP

GDE Server

Ijet

JHink/]-Trace

T1 Stellaris

Nu-Link

PE micro Device description file
ST-LINK

Third-Party Driver [ Override default
TI MSP-FET

1408 $TOOLKIT_DIR$\CONFIG\debugger\GigaDevice\GD32F103x

Corcel

16
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Figure 3-10. IAR CMSIS DAP configuration

Options for node "GD32103B_EVAL" X

Category: Factorp Settings

General Options
Static Analysis
Runtime Checking 2
CJC++ Compiler Setup Breakpoints
Assembler
QOutput Conwverter
;:T;D:l:;:: @ Auto Override default
Linker ) From file
Debugger
Simulator () Explicit Select
CADL 1
Interface Explicit probe configuration
GOB Server
IHet OJTAGa Multi-target debug system
Jink/J-Trace
TI Stellaris ® SwWD
Mu-Link
PE micro
STALINK 0
Third-Party Driver
TI MSP-FET Interface 4

TIXDS 6MHz v

Probe config Probe configuration file

Target with multiple CPUs

0K Cancel

In the menu bar "Project” drop-down option "Download", click "Download active application”
and wait for the progress bar to complete the burning, as shown in Figure 3-11. IAR
download button and Figure 3-12. IAR download progress bar.

17
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Figure 3-11. IAR download button

Projed:lCMS\S-DAP Tools Window Help

Add Files... - LG > 8 b= < 2 <] |
Add Group...

Impart File List...
Add Project Connection...

Edit Configurations..,

Remove

pde "gd32fl0x.h"™
Create New Project... pde "gd32fl03b_eval.h™

Add Existing Project... pd= "systick.hv

Options... Alt=F7

rief main function

Version Control System p param[in] none
aram[cut] none

@ Make F7 petval none

Compile Cirl+F7 | )
in {woid)

Rebuild All

Clean stick config():

Batch build... F&

enable the LEDs clock *,
C.STAT Static Analysis y fu_periph_clock_enable (RCU_GPIOC) :

Stop Build Ctrl+Break
GEY

o Download and Debug Ctrl=D

reset GPIO

5 LEDs GF

» | Debug without Downloadi

ST RLATITIRA I EET D, io_bit_reset(GPIOC, GPIO_PIN 6 | GEI
Attach to Running Target
Make & Restart Debugger Ctrl+R

Restart Debugger Ctrl+Shift+R

pilefl){

i bit set (GPTOC. GETO PTH Ai:
Download » Download active application Alt+D

SFR Setup Download file...

Erase memory
_bit_set(GPIOC, GPIO_PIN_7):

N g = 200

ok CMSIS-Pack Manager

Open Device Description File delay &/

Save List of Registers... delay_lms {200}

Figure 3-12. IAR download progress bar

Busy

Starting debugaer session: Fashing

Downloading: Downloading

e . e e . . . . . . N Y
A R O T Y T O T O T O W

Cancel

Programming with Eclipse

Connect GD-Link V2 to the target chip according to the hardware connection described in the
Pin definitions and wiring methods section. Connect the USB interface of GD-Link V2 to
the PC, and wait for LED2 to enter rapid blinking mode. Open the Eclipse software and click

"RUN" menu and select the dropdown option "Debug Configurations..." to enter the

"Debugger"” tab, as shown in Figure 3-13. Access the "Debug Configurations" interface.

Configure the OpenOCD path correctly and fill in the cfg file to be used in the "Config options"
section, as demonstrated in Figure 3-14. Configure the "Eclipse Debug" tab in the Eclipse
Debug Configuration interface.

After completing the configuration, click the "Apply" button to save the settings. Then, select

18
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the "Debug" button, and when the "Confirm Perspective Switch" window appears, click "YES"
to confirm. This will initiate the code download and take to the debugging interface, as
illustrated in Figure 3-15. Enter the debugging interface in Eclipse.

Figure 3-13. Access the "Debug Configurations" interface

= eclipse-workspace - ProjectjApplication/main.c - Eclipse IDE
—

File Edit Source Refactor MNavigate Search ProjedWindow Help

il | o Q v B % -] | i E OJ Run Last Launched Ctrl+F11
%% Debug Last Launched F11
{5 Project Explorer i = O [ maine 52 s |l s e
B %S Y § 499 int main(voi Profile History 3
4 7% Project (in Eclipse_project) ;‘: { systick Profile As >
4, Binaries 52 gd_eval | Profile Configurations...
* [m! Includes 53 gd_eval |
licati 54 gd_eval | Run History 3
> iy Application 55 gd_eval |
> 2y CMSIS 56 O Runis N
» (= Debug 57 Nhile_(la Run Configurations...
58 /* 1y
> ey Doc 59 gd_e Debug History 3
> Gy Ld 60 gd_e 5
> Gy Peripherals 61 dela -
62 /* 4 Debug Configurations...
> @y Startup 53 gd_d
» Gy Utilities o — Breakpoint Types +
PR Problems & T4 ® Toggle Breakpaint Ctrl+Shift+B

CDT Build Console [f ® Toggle Line Breakpoint
Toggle Watchpoint

make --no-print-d Toggle Method Breakpaint
arm-none-eabi-obj . .
"Project.dump” w  Skip All Breakpoints Ctrl+Alt+B

Remove All Breakpoints
Invoking: GNU Arm

arm-none-eabi-obj % External Tools >
Einished huilding

Figure 3-14. Configure the "Eclipse Debug" tab

o — -
-
S Debug Configuations T T N - - —
Create, ge, and run config q
CEREX|BY - Name: Project Debug (1)
type filter text [2 Main %7 Debugger | B+ Startup| > Source [T] Common &, SVD Path
[€] C/C++ Application OpenOCD Setup =
[E] C/C++ Attach to Application Start OpenOCD locally
C/C++ Container Launcher 3 - — ey " - E
it th: th it .
5] i+ Postmortem Debugaer xecutable pai {openocd_path)/${openacd_executable} ariables
[c] C/C++ Remote Application Actual executable: Edeclipse\ieclipse_toolchain\OpenQCD\binfopenacd.exe
Cif C/C++ Unit

Tio change 1t use the global or worlepace preferences pages or the project properties page)
[5] GDB Hardware Debugging

4[] GDB OpenOCD Debugging
[€] Project Debug (1) Telnet port: 4444
[£] GDB PyOCD Debugging
GDB QEMU Debugging =
4 [5] GDB SEGGER J-Link Debugging IConﬁg options: | -f §{eclipse_home}\eclpse._toolchain\OpenOCD\scripts\target\openocd_gdlink_gd32f10x.cfg I P
[] Project_RISCV Debug L

[€] Project Debug -

i Launch Group Allocate consale for OpenOCD Allocate console for the telnet connection

mn

GDB port: 3333

Tel port: 6666

GDB Client Setup
Start GDB session

Executable name:  ${cross_prefijgdb${cross_suffix}

Actual executable: arm-none-eabi-gdb -

Appl
Filter matched 15 of 16 items
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Figure 3-15. Enter the debugging interface in Eclipse

© ARM Workspace - GD32F10x/Application/main.c - Eclipse - o X
File Edit Source Refactor Navigate Search Project Run Window Help
[ C -l & @ BNl EN2e PSS B R0 @S-l B e D [Quick Access] || B9 | B
‘s | 4 Debug 12 | T = 8 WiRegisters 13 wie|nest v= 8
~ B GD32F10x.elf A Name Value Description
@ Thread #1 (Suspended : Breakpoint) B >
O | @ mainc 12| =0 | § Memory X =8 = S =5
- )!h:gmingdelayloml - 10000; cmeOdo [emerlocaon bere ]| &)t e
73 3 ’ _— & main: S
7} L0 +08000%e0:  push  {r3, lr}
75 © Confirm Perspective Switch x 030009¢2: bl @x8000adc <systick_config> H
768 /71 88 gd_eval_led_init(LED2);
77 \brief main function 0 “This kind of launch i openthe iy it 80009e6:  movs N
78 \papam[in] none suspends. osogo9es: bl oxB0001bc <gd_eval led init>
79 \poram{out] none a2 gd_eval_led_init(LED3);
8 \retval  none T Debug perspectiveis des festion debuging. It esooosec:  movs  rds #1
e incorporates views for displaying the debug stock. veriables and breakpoint esooooce: bl exdeoo1bc <gd_eval_led inits
5 management. E) gd_eval_led_init(LED4);
839 int main(void; § ) oseeesiz:  movs  re, #2
8 [ (void) LErme e el prE T e80009fs: bl exaeeelbc <gd_eval led init>
85 J* configure ; o1 gd_eval_com_init(EVAL_COMB);
36 At [JRemember my deciion eseeasfs:  ldr  re, [pc, #1e4] ; (exBeERass <maint13z>)
- J* initili eseeasta: bl exBapo2ec <gd_eval_con_inits
58 gd_eval led [ v | 92 £d_eval_key_init(KEY_WAKEUP, KEY_MODE_GPTO);
39 2d_eval led_ esseasfe: movs  rl, #0
on Y T eseaace:  mov , ri
< > esepan2: bl oxB00254 <gd_eval_key_init
5 o . 3 - a5 printf("\r\nCK_SYS is %", rcu_clock_freq_get(
B Console 27 B X% BRSO "0 & bpressions X O omsees: movs  re, 0
(GD32F10x GD32F103x8 [GDB OpenOCD Debugging] openocd.exe 08600208: bl @xgave64c <rcu_clock freq_get>
Info : gd32f16x.cpu: target has 6 breakpoints, 4 watchpoints Py o, | o Toc, 4651 5 (oxooosass <maint136)
Info : gd32f1ex.cpu: external reset detected g osooonn: | b1 oraBonba cointrs
Info : starting gdb server for gd32flex.cpu on 3333 - o : prntf (AN e . reu clock frea_get(
Info : Listening on port 3333 for gdb connections ococoata: | mome o wr o reuelock
Info : accepting 'gdb’ connection on tcp/3333 Expression ooooone: | by oxia00s4c <rcu_clock freq_get>
target halted due to debug-request, current mode: Thread e delay ooooont: | tov elocktreq s
XPSR: £x21860800 pc: GX0BEER2Se msp: 0X20002095 - : :
i A & Add new expression @seogalc:  ldr  re, [pc, #76] ; (6x308@abc maintl4o>)
e e s esgepale: bl ©xB000bSS <printf>
e e e 97 printf("\r\nCK_APB1 is %d", rcu_clock_freq_get
warn : Prefer GDB command “target extended-remote :3333" instead of “target remote :3333" ooooonze: | oo elocktreq s
target Nalted due to debug-request, current mode: Thread osooora.  1ar  ro, [pc, #68] ; (ox8006aT <maintied>)
;mi;‘ﬂmn e M:;ied m=p: ¢ > esec@azc: bl @xB800b54 cprintf>
e P printf("\r\nCK_APB2 is %d", rcu_clock_freq_get
o8eeeaz0: movs  re, #3
target halted due to debug-request, current mode: Thread ocooanss: | b3 oxia00sdc <rcu_clock freq get>
PSR pe: nsp: semihosting v | [ o0 v
< > e > < >
Writable Smart Insert | 86:22 : )

3.2.2. GD-Link Programming

Connect GD-Link V2 to the target chip according to the hardware connection described in_Pin
definitions and wiring methods section. Connect the USB interface of GD-Link V2 to the
PC, and wait for LED2 to enter rapid blinking mode. Open the GD-Link Programmer software
and select the JTAG / SWD programming interface and configure the communication speed

in the "Properties" window. Refer to Figure 3-16. GD-Link programmer programming

options configuration for an illustration of GD-Link Programmer programming options.

Figure 3-16. GD-Link programmer programming options configuration

% GD-Link Programmer 4.6.10.13769 — o X

© File(F) Targetl GD-lnk Refresh EGitlE) View() Help(H)

Propertias Window -
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 Device(GD-Link)

Connect USB[Device 0]

Firmware Ve... Unknown
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B MCU Info
MCU Part No. Unknown
Endian Unknown
CheckcorelD Yes
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Use RAM Yes
RAM Address Unknown
RAMSze  Unknown

up Unknown
& Flashinfo
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Flash Base ..  Unknown

i

Outp

Show initial information snd softrare infornation here

W« > W \Status

Ready CAP NUM SCRL _:|

Click the "Target" dropdown menu and choose the "Connect" option. Check the "Output"

window for a message indicating "Connection successful." At the same time, the detailes
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information about the connected target chip, including its specific type are listed in the
"Properties" window. Refer to Figure 3-17. Connecting the target chip in GD-Link
Programmer for an illustration of GD-Link Programmer successfully connecting to the target
chip.

Figure 3-17. Connecting the target chip in GD-Link Programmer

% GD-Link Programmer 4.6.10.13769

© File(F) | Targetm | GD-link Refresh EditlE) View(V) Help(H)
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Drag and drop the binary file, "xxx.bin" or the executable file "xxx.hex" into the GD-Link
Programmer software. When using the "xxx.bin" file for programming, a dialog will appear on
the host computer's software, prompting to enter the starting address for the download. After
entering the correct download address, click the "OK" button. Then, select the "Target"
dropdown menu and choose the "Program" option. The software will start downloading the
program to the target chip. Wait for the progress bar to reach 100%, and a message will
confirm the successful download, as shown in Figure 3-18. GD-Link Programmer _burns

target chip.

Figure 3-18. GD-Link Programmer burns target chip

i GD-Link Programmer 4.6.10.13769
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3.2.3.

Offline programming

Connect the USB interface of GD-Link V2 to the PC, and wait for LED2 to enter rapid blinking
mode. Open the GD-Link Programmer software. Click "GD-Link" menu bar and then choose
"Configuration" to configure the parameters of offline programming, referring to Figure 3-19.
GD-Link V2 offline download parameter configuration. The following configurations can

be performed using this interface:

B Whether to enable read protection after offline programming completion.
B Erase method selection: full chip erase or page erase.
B Limit the number of offline programming downloads.

Click the "OK" button in the offline programming parameter configuration interface to save the
settings. After configuration, in the menu bar, click "GD-Link" and then "Update File" to enter
the file update interface. Referring to Figure 3-20. GD-Link V2 offline download file update
configuration. Select the specific part number of the target MCU, add the xxx.bin file, specify
the download address to the target chip, and click the "Update" button. Wait for the progress
bar to reach 100% to complete the file update, as shown in Figure 3-21. Offline download
file updated to GD-Link V2.

File updating supports one-time burning for BOOT+APP functionality. The user can continue
to click the "Add" button to add a second bin file, specify the burning address. The file update
allows to add a maximum of 8 bin files. The addition process is illustrated in Figure 3-22.
Simultaneously adding BOOT+APP offline download file update to GD-Link V2.

For GD32W515 series MCU, offline programming also supports option byte configuration.
When selecting the MCU part number as GD32W515 series MCU in the "GD-Link Update
File Configuration" window, click the "Configure OptionBytes" button. In the pop-up window,
perform the option byte configuration. After configuration, click the "OK" button to save the
relevant settings, as shown in Figure 3-23. Offline download configuration option byte

feature.

Figure 3-19. GD-Link V2 offline download parameter configuration

# GD-Link Programmer 4.6.10.13769

File(F) Target | GD-link | Refresh Edit(f] View(V) Help(H)

Update File

1
Update Firmware
GD-Link Configuration X
Offine-Programming Configuration
I~ Secure After Programming Erase Option | Chip hd
I Program Limit Count |50 1 2
Online-Programming Configuration
[ Secure After Programming [~ Reset Before Programming
[¥ Run After Programming
Product SN
I~ write SN SN Address:0x |00000000
Next SN |1 SNIncrement: |t
OK I Cancel |
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Figure 3-20. GD-Link V2 offline download file update configuration

55 GD-Link Programmer 4.6.10.13769

FilelF] Target) | GD-link | Refresh  Edit(f) View() Help(H)
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SES
5 o
3 =

O - i
. mm

i Windows (C)
- FE (DY)

Delete Add 3 - SN ()
Cancel Update :

Enter Programming Address S

v < 3

SEEE(N): [test led.bin “

Figure 3-21. Offline download file updated to GD-Link V2

% GD-Link Programmer 4.6.10.13769

© File(f) Targetl) GD-link Refresh EditfE) View(V] HelpiH]
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Reallime:  Updating Offine-Programming Fie Successfully!
Time Cost:  0.328s

4 =]
Delete Add

Figure 3-22. Simultaneously adding BOOT+APP offline download file update to GD-
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3.2.4.

Link V2

i GD-Link Programmer 4.6.10.13769 Enter Programming Address X %
© File(F) Targetfl GD-link Refresh EditlE] View(] Help(H] 3
]« Fl EETest” »
Starting Address: 0x |3000000
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S "] APP_0x08040000.bin 2021/4/16 952 BIN Xf
fa BOOT 0x08000000.bi 2021/4/16 952 BIN Xt
e 7 B s BoOT ¢ in /4
File Index | File Path |__Flesze (ddress = 8r v < >
1 E:\Test|BOOT_0x08000000.bin 0x1004 8000000 -
2 7 E:\Test|APP_0x08040000.bin 0x1004 0x8004000 ZHEEN): ‘APP_OxOWOOOU‘bin v ‘*.bwr\-*.hex V|
7 g
6

Figure 3-23. Offline download configuration option byte feature

s GD-Link Programmer 4.3.7.9536 - o X
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After updating the offline burning file to GD-Link V2, refer to the Pin definitions and wiring
methods section related to hardware connection with the target chip. Manually press the K1
button, if LED1 entering rapid blinking mode, indicating that the offline burning process is
ongoing. When the buzzer beeps, it signifies the completion of the offline burning. At this time,
LED1 is always bright. If the buzzer does not beep, and LED1 is turned off after blinking, it
indicates an offline burning failure.

Machine singal triggered programming

GD-Link V2 offers machine-triggered programming functionality. The signal interface pinout
diagram is shown in Figure 3-24. Machine signal programming pin distribution

schematic _diagram. The functions of each pin for the machine-triggered programming

interface are described in Table 2-1. GD-Link V2 pin function definitions. After updating
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GigaDevice
the programming file into the programmer as described in the offline programming section,
users can initiate the programming process by providing a 100ms low-level pulse signal to
the T_START pin. During the programming process, the T_BUSY pin remains at a low-level
signal. When the programming is successful, the T_GOOD pin generates a low-level signal,
while a low-level signal on the T_NG pin indicates a programming failure.
Figure 3-24. Machine signal programming pin distribution schematic diagram
GND
— IP3
. L
T NG >
T BUSY 3
T GDOD 1
T START 5
4=1P2 54
Table 3-1. Machine signal programming pin function definition
Pin
Pin Name Description
Number
1 GND Power ground
2 T_NG Defaults to a high level. When burning fails, this pin goes to a low level.
Defaults to a high level. When burning is in progress, this pin goes to a
3 T_BUSY 9 9 prog Ping
low level.
Defaults to a high level. When burning is successful, this level goes to a
4 T_GOOD
h low level.
Defaults to a high level. When this pin receives a low-level signal with a
5 T_START _ _
width of 100ms, burning starts.
3.2.5. Virtual USB disk drag and drop programming

Insert the GD-Link V2 USB into the PC port. There will be a USB mass storage device in the
PC device manager, and a GigaDevice disk with the GD logo will appear in the local disk. As
shown in Figure 3-25. USB mass storage device and Figure 3-26. Virtual USB drive.
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Figure 3-25. USB mass storage device

% Device Manager
File Action View Help
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Figure 3-26. Virtual USB drive
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Windows (C:)

|
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|
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GigaDevice (E:)

Q i
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Double-click to open the disk. Inside the disk, there is a CONFIG.TXT file. By modifying the
content of this file and saving it, the initialize the programming parameter can be configured.
The content of the CONFIG.TXT file is shown in Table 3-2. CONFIG.TXT file content.

Table 3-2. CONFIG.TXT file content

# Program config:

Target CPU: ARM

Program Flash start address: 0x08000000
Erase method: Page

Reset method: Software

Read protection: Disable

Sram start address: 0x20000000
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Note: Keep the format of this TXT UTF-8. Please configure programming parameters follow the format]
before programming. E.g:

# Program config:

Target CPU: ARM

Program start address: 0x08000000

Erase method: Chip

Reset method: Software

Read protection: Disable

Sram start address: 0x20000000

The options and descriptions for each parameter configuration are as shown in Table 3-3.
Drag-and-Drop programming configuration parameter definitions.

Table 3-3. Drag-and-Drop programming configuration parameter definitions

Parameter Options Description
] ARM Select ARM as the target chip core
Target MCU core architecture -
RISC-V Select RISC-V as the target chip core
Program flash start address
OXO8XXXXXX
Program flash start address OX08XXXXXX
OXOCXXXXXX Program flash start address OXOCXXXXXX
Page Flash erasing method is page erasing
Erase method - ) ) . .
Chip Flash erasing method is full chip erasing
Reset method after completing chip download
Software )
is software reset
Reset method . :
Reset method after completing chip download
Hardware )
is hardware reset
Target chip's SRAM start address is
OX2XXXXXXX
OX2X XXX XXX
Sram start address - -
Target chip's SRAM start address is
OX3XXXXXXX
OX3XXXXXXX
Select SWD as the download interface(only
SWD
. for ARM)
Debug interface -
Select JTAG as the download interface(only
JTAG
for RISC-V)

After configuring the programming parameters, save and close the file. Refer to the Hardware
introduction section, connect GD-Link V2 to the target chip via SWD (GD Cortex-M core
MCU) or JTAG interface (GD RISC-V core MCU) correctly, then copy or drag the binary
xxXx.bin or executable file xxx.hex generated by the IDE or compiler toolchain to the
recognized GigaDevice disk device. The programmer will automatically identify the target chip
and complete the file programming.

After programming is complete, the virtual USB device will unmount and then remount from
the disk. Once mounting is complete, open the GigaDevice disk. If the disk contains only the
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3.3.

3.3.1.

CONFIG.TXT file, it indicates a successful file programming. If a FAIL.TXT file appears in the
disk, it indicates a programming failure. Double-click to open FAIL.TXT and check the reason
for the programming failure.

Note:

1. When the debugger loses power and is unplugged and reconnected, the previous
programming parameters will revert to default values.

2. The binary xxx.bin file should be generated by the compiler and the corresponding
download target address should be filled correctly, otherwise, programming failure may occur.

Debug function

SWD /JTAG debugging

Debugging with KEIL (version 5.27 and above):

Complete the KEIL configuration according to IDE programming chapter, click the icon
button of "Start/Stop Debug Session” in the KEIL menu bar to enter the debugging interface,
as shown in Figure 3-27. KEIL debugging interface.

Figure 3-27. KEIL debugging interface

K2 D & GD32F10x_Firmware_Library\Template\Keil5_project\Projectuvprajx - uVision - o x

File Edit View Project Flash Debug Peripherals Tools SVCS Window Help

5@ B [e=|p | | # euzer connig vae@d e o @-|@-| A
FEHO v n s D@BEsE O0-3-0- 2@ %
Registers 2 E1 Disassembly L =)
Gx080003E6 DR For e, 00 %
51: systick_config():
W 0544 systick_config

52: gd_e | init (LED2):
0%080003EC 2000 MOVS x0, #0%00

0%080003EE FTFFFFED BL.W 0%080002CC gd_eval_led_init v

< >
] startup_gd32fi0x_md.s ] main.c w X Call Stack + Locals L <]
a2 ~ || Name Location/Value
43E1/*! @ main 000000000
a4 unction
45
46
a7
a8
4% int main(veid)
505t
M s systick config():
52 gd_eval_led_init (LED2) ;
53 od_eval_led_init (LED3):
54 gd_eval led init (LED4):
55 gd_eval led init (LEDS):
0. 00044650 56 - - -
S7H- - while(1)¢
58 *.turn-¢ led2, -turn-off leds *
59 gd_eval_led on(LED2):
€0 - gd_eval_led off(LEDS):
€1 delay_lms (1000):
62 /% -tux off led2 *
63 gd_eval_led on(LEl
e gd_eval led off(LE
65 delay . :
€6 * rn-off led3 *
&7 gd_eval led
68 gd_sval led
€9 del
7 /n e [ Tarn-off leds s/ vl | ol
Bl roject | = Registers < > | Gcanstack + Locats | B Memory 1
Browser L - |
Symbol: [ ] Memory Spaces: # eram
Rteron: [ Macros Data L
¥ const
Functions Sfr(Bits) [ som
Parameters | Types ¥ code
File Outine: [<allfiles> -
CMSIS-DAP Debugger £1: 0.00044650 sec. L51 C1 CAP NUM SCRL OVR R /W

Debugging with IAR (version 8.50 and above):

Complete the IAR configuration according to IDE programming chapter, click the icon button
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of "Download and Debug" in the IAR menu bar to enter the debugging interface, as shown in

Figure 3-28. IAR debugging interface.

Figure 3-28. IAR debugging interface
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Debugging with Eclipse

Complete the Eclipse configuration and debugging according to IDE programming chapter.

3.3.2. SWO function

The Serial Wrie Output (SWO) function uses the ITM (Instrumenttaton Trace Marcrocell)
module in the Cortex-M kernel to output debugging information in the kernel through the SWO
pin of the chip. The connection mode between the burner and the chip is referred to Figure
2-4. SWD + SWO interface connection diagram.

Note: For details about whether the chip supports the SWO function, see the corresponding
user manual and datasheet.

SWO configuration in KEIL

Select the Debug tab in Options for Target and select CMSIS-DAP ARMv8-M Debugger from
the drop-down list, referring to Figure 3-29. SWO configuration step 1 in KEIL.
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Figure 3-29. SWO configuration step 1 in KEIL
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Select the Trace tab in Settings, and the configuration interface is shown in Eigure 3-30. SWO

configuration step 2 in KEIL.

Figure 3-30. SWO configuration step 2 in KEIL
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The Trace pin is enabled in the code. For an MCU with Trace mode configuration, the Trace
mode needs to be configured as asynchronous mode, as shown in Table 3-4. Trace mode

enable. For details about how to enable Trace mode, see the Debug chapter in the user

30



GigaDevice

GD-Link V2 Adapter User Guide

manuals of each series of MCUs.

Table 3-4. Trace mode enable
DBG_CTL |= DBG_CTL_TRACE_IOEN;

In the code, the serial printf output is redirected to the ITM output, and the added code is
shown in Table 3-5. Printf retarget.

Table 3-5. Printf retarget

#define ITM_Port8(n) (*((volatile unsigned char *)(OXxEO0000000+4*n)))
#define ITM_Port16(n)  (*((volatile unsigned short*)(OXEO000000+4*n)))
#define ITM_Port32(n)  (*((volatile unsigned long *)(0XE0O000000+4*n)))

#define DEMCR (*((volatile unsigned long *)(0OXEOOOEDFC)))
#define TRCENA 0x01000000

int fputc(int ch, FILE *f)

{
if (DEMCR & TRCENA)
{
while (ITM_Port32(0) == 0) {};
ITM_Port8(0) = ch;
}
return(ch);
}

Enter the debugging interface, select "View" -> "Serial Windows" -> "Debug(printf)Viewer",
open the serial port printing interface, run the code at full speed, and the printed information
will be displayed in the Debug(printf)Viewer window. The Debug(printf)Viewer window in is
shown in Figure 3-31. Debug (printf) viewer window in KEIL.
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Figure 3-31. Debug (printf) viewer window in KEIL
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Enter the debugging interface, choose "View" -> "Analysis Windows" -> "Logic Aanlyzer",

open the logic analyzer window, add the variables to be observed, run the code at full speed,

and the value of the variable will be displayed in the logic analyzer window through the

waveform. The Logic Aanlyzer window is shown in Figure 3-32. Logical Analyzer window

in KEIL.
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3.4.

Figure 3-32. Logical Analyzer window in KEIL
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Virtual serial port printing

When the GD-Link V2 USB is inserted into the PC port, a USB serial device will appear on
the PC Device Manager port (COM and LPT) interface (there is no driver for WIN10 system,
and the corresponding driver should be installed for win7 system), as shown in Figure 3-33.
USB serial device, refer to Figure 2-5. Serial interface connection diagram. Connect GD-
Link V2 to the serial port pin hardware of the target chip, configure the correct serial port baud
rate and other information in the serial port debugging assistant, and write the data to be sent
to the target MCU serial port receiver through the serial port debugging assistant. The target
MCU can also print the information to be printed through the USB port of the burner to the
upper computer interface of the serial debugging assistant through the serial port transmitter
and display it, as shown in Figure 3-34. USB virtual serial printing.
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Figure 3-33. USB serial device
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Table 4-1. Revision history
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